ASSISTIVE TECHNOLOGY

LAP TOP/SOLO SUITE




Laptop with Solo Suite

Subject: Social Studies
~arade: Any

Initial set-up (front loading): Teachers need to know what etext (electronic text) or websites they
want the students to access. They can be preloaded onto the students’ assignment.

Task(s): Write a research essay.
Activity:

1. In Draft Builder create a list of topics or questions to be answered in either web or linear
format. The questions can be levelled according to topic and subtopics.

2. Move to Read:Outloud. Notice our questions are on the right side of the screen. Open etext
and/or web pages and have it read to you using the speech tool. Highlight notes (colour based
on level of question). These can be dragged over to the corresponding question — if so it will be
in guotations.

3. Move to Write:Outloud and also open Co:Writer if needed. Notice that draft and answers are
on the left hand side of screen. These can be dragged over to the written portion if needed.
Start filling in the gaps and listen to what you have written.

4. Don't forget to use the Bibliography Wizard

Other Thoughts/ideas:

Website: www.donjohnston.com



How do I save etext?

The trick to downloading etext is to make sure that you save it as a "text”
file. This will allow you to bring it into any word processor that you are
working with. Saving the file on your computers hard drive will ensure that
you can access it again for using in other applications or for a different
purpose.

Here's how....

1. Make sure that the etext that you want to work with is open on the
screen.

2. Select the File menu and select Save As.

3. Name your file in the File Name box. Most Internet files will have
long, odd names! Give it a name that you will recognize later on.

4. Change the file type in the File Type box. Click the drop down arrow
beside the file type box and choose "txt" file. If you don't change the
file Type, it will simply be saved as a web-page and when you go to open
the file it will open on the internet.

5. Make sure that you know where you are saving the file; you want to be
able to find it later on. You might want save it in a folder in you're My
Documents folder called My ebooks.

How do I bring etext into my word processor?
Cutting and pasting is the most universal method of bringing text into a word
processor. The steps for doing so are...
1. Open the saved "text” file.
2. Select the Edit menu and then Select All. Your text will become
highlighted.
3. Select the Edit menu and then Copy.
4. You can now close the text file and open the word processor that you
want to paste into.
5. With the word processor that you want to work with open, select the

Edit menu and then select Paste.

Note: Text retrieved from the Interet is often formatted by placing forced enters at the
end of each line. Your might need to fix the formatting and delete any web garbage
(a.k.a. advertising that came over with the text).



SOLO

SOLO Literacy Suite combines the power of innovative technologies and a
teacher-friendly management system. SOLO will support any size student
population for differentiated writing approaches across the curriculum.

Co:Writer—intelligent word prediction

Write:OutLoud—falking word processor

Draft:Builder—graphic organizer

Read:OutLoud—Text reader (supports electronic files including NIMAS)
Teacher Central—an intuitive management system used to create student data
reports and assign individual student preferences.

CO:WRITER

Co:Writer is a powerful word-prediction program created for struggling writers to
help expand their vocabulary and improve written expression. With Co:Writer
students are able to produce grammatically-correct and topic-specific sentences
within any word processor.

The secret to Co:Writer's success is Linguistic Word Prediction™. No other
program uses this intelligence to accurately predict phonetically spelled words
while offering support to produce longer sentences with independence and
confidence.

READ:QUTLOUD
Support ALL Electronic Content

. Text-to-speech reads electronic content

. Built-in browser supports internet research

. eHighlighter and Note tools cultivate text-to-self connections
. Templates prompt application of comprehension strategies

. Franklin Dictionary helps build vocabulary

WRITE:OUTLOUD

Write: OutlLoud is an award-winning talking word processor and writing software
program built specifically for students in grades 3-12.

With Write:Out:Loud your students will write more effectively, more often and
have more enthusiasm to share creative thoughts on paper.

DRAFT:BUILDER

Using Draft:Builder, a writing software technology that breaks down the writing
process, your students will enjoy the pre-writing process and ultimately write
effective essays and papers as they:

. build better visual maps to prepare their plans and goals
. construct visual outlines to organize their ideas
take better notes to emphasize and process important facts

From: Donlohnsons Web Site fwww.donichnston.com}



Read:Outloud™ SOLO Edition
Getting Started Learning Checklist

See how much you know and have learned about Read:OutLoud using this skills checklist.

Tutorial 1

Launch Read:OutLoud

Sign In as a Learner

Preview an Assignment Template

Open an Assignment Template

OD0D00DO

Read text using audifory supports
(1 Speak Locked Text
) Stop speaking
{J Highlight text for speaking
L3 Speak text

£} Read All text

g Spéak Paragraph
Use the Dictionaky .
Use the eHighlighters 1o highlight eText to add Subtopics
Add Notes (o the Supported Reading Guide
Move Subtopics in the Supported Reading Guide
Indent Subtopics in the Supported Reading Guide
Delete Notes and Subtopics in the Suppoerted Reading Guide
Save/Save As
Print the Supported Readiﬁg Guide as a study guide

Coo0CcooDp o

Tutorial 2

Launich Read:OutLoud

Sign In as a Teacher

Preview an assignment

Open an Assignment Template
Modify an Assignment Tempiate
O Delete Locked Text

O Add Locked Text

U Edit Locked Text

L} Save an Assignment Template

OCo00OC

U Assign an Assignment Template to Learners

© Don Johnston Incorporated Checklist



Ready for More
U Navigate in the eText
L] Move to Beginning/End of Document
(1 Move to Next Sentence

[J Select Sentence

C

Resize the views with the Slide Bar

(]

Speak text
1 Repeat last text spoken
Cut/Paste text
Copy/Paste text
Use Re-Highlight
Use the Bibliographer '
" Add eText
L) Use Add eText
0 Connect to the Web
L) Capture Web Page

Move among eText pages using Next Tab

CoO0oOoB

C

O Resize eText
0 Grow Selection
{1 Shrink Selection

Remove eText Tab

(S

Use Map View

U1 Add Picture(s)

03 Add Picture(s) provided within Read:QutLoud

U Add your own pictures or Hustrations to a Read:QutLoud document
Outdent Subtopics in the Supported Reading Guide

Add Outline Template

C0C

Format eText

[} Change Font Style and Size

0 Change Alignment

0 Change Line Spacing

{3 Set Colors in the Supported Reading Guide

0 Set text-to-speech options from the Speech Menu
U Turn Speech On/Off

) Turn Speak Toolbar and Dialog Boxes on

{3 Highlight Word-by-Word

Checklist © Don johnstor Incorporated
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Set Voice Settings

0 voice

(} Rate (speed)

O Pitch

1 volume

Adjust speech feedback as you type

Use the Pronunciation option from the Speech menu
Use Check Spelling in eText |
Cue Misspelling

Show{Hide Locked Text

Show/Hide Toolbar

Modify Print Settings

Change default assignment settings using Student Preferences in Teacher Central

Additional Read:Outloud Resources

I T v I o

Help Menu

Read:OutLoud Getting Started

User Guide

Sample Assignment Templates

Sample eText

Sample images

Don johnston Learning Resources on the Web

www.donjohnston.com/djlearning/readoutloudfrm.htm

U Getting Started Tutorial
0 Product Story

Q Standards Sheet

U Learning Checklist

U Research

© Don johnston Incorporated

Checklist
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Draft:Builder® SOLO Edition
“Getting Started Learning Checklist

See how much you know and have learned about Draft:Builder using this skills checklist.

Tutorial 1

L} Launch Draft:Builder

L) Sign In as a Learner

0O Preview an assignment

O Open an existing assignment
[} Read text using auditory supports
O Speak Locked Text

0 Speak text

Madify an OQutline

O Add Subtopics

0O Delete Subtopics

O

L Organize an Outline
U Indent Subtopics
O Cut and Paste Sl@_;%_opics
(1 Move Subtopics by dragging
0 Navigate among views
U Move from Outline to Notes
U Move from Notes to Draft
Add a New Note
Add text to Notes
Create & Reference using the Bibliographer
Link a Note to a Reference
Organize Notes into a Rough Draft
Highlight text
Sefect Al
Save/Save As
Copy and Paste text into a word processing program

00000000

© Don fohnston Incorporated Checklist



Tutorial 2
(J Launch Draft:Builder
 sign In as a Teacher
(O Preview an assignment
L} Open an Assignment Template
{0 Modify an Assignment Template
(] insert Locked Text
O Add Subtopics
0 Indent Subtopics
[ Delete Subtopics
L1 Save an Assignment Template
U1 Assign an Assignment Template to Learners

Ready for More

0 Navigate

U Move to Beginning/End of Document
) Move to Next Sentence

L Select Sentence

Show/Hide Locked Text

Show/Hide Toolbar

Zoom in on text

Resize the views with the Slide Bar

(A o I o

Use Map View
0 Toggle between Concept and Tree Views

O

Outdent Subtopics

O

Resize text
L) Grow Selection
{J Shrink Selection
g Set Colors
) Speak text
U Repeat last text spoken
U Stop speaking
(3 Set text-to-speech options from the Speech Menu
QO Turn Speech On/Off
I Turn Speak Toolbar and Dialog Boxes on
0 Highlight Word-by-Word

Checklist © Don Johnston Incorporated



(I Ser Voice Settings
U voice

U Rate (speed)

U Pitch

3 Volume

Adjust speech feedback as you type
Use-the Pronunciation option from the Speech menu
Add Outline Template

Use Check Spelling

Cue Misspelling

Use the Dictionary

Change Font Style and Size

Uo0o0oocooo

Print assignment

Q From Print One button

U Modify Print Settings

8 Change default assignment settings using Student Preferences in Teacher Central

Additional Draft:Builder Resources

U Help Menu _

0} Draft:Builder Getting Started

(1} User Guide

U Sample Assignment Templates

QO Sample Outline Templates

L1 Don Johnston Learning Resources on the Web

WWw.doniohnston.comldi]earningidraftbuilderfnn.htm

O Getting Started Tutorial

L Product Story

U Standards Sheet
() Leaming Checklist
O Research

Checklist

© Don Johnston Incorporated
" X0V18 9204 02/05



Co:Writer® SOLO Edition
Getting Started Learning Checklist

See how much you know and have learned about Co:Writer using this skills checklist.

Tutorial 1

Launch Co:Writer

Create a New Writer file

Choose a template

Connect Co:Writer to a word processing program
Work in Sentence Window

Expand the Palette

Type a sentence using linguistic word prediction

Add more sentences to a document

o R I

Use the Palette

L1 Select a Topic Dictionary
L) Use the eWord Bank

[J Hide Co:Writer

[} Use More Guesses

L1 Use Erase Word

0 Quit Co:Writer

Tutorial 2
U Launch Co:Writer
O Create a New Writer file
0 Change Writer file setiings using the Settings dialog
J Change Window type
{] Change Number of Guesses
03 Change Text and Background Color
L) Change Flexible Spelling setting
U Change Speech Settings (Windows only)

0 Connect Co:Writer to a word processing program

© Don johnston !ncbrpomted Checklist



Tutorial 3

U
]
a

Launch Co:Writer
Sign in as a Teacher
View and access Co:Writer Teacher Options

Ready for More

COo0000CO0ODO0OCO0COo0O0O00O0O0O

Work in Word Window

Work in Paragraph Window

Erase Sentence

Speak Word

Speak Sentence

Turn Speech On/Off

Scan Guesses

Chop Word

Send Text to the connected application
Use Flex-Word

Use True Keys

Capture Words and save in the Collected Word Dictionary
Work in Talk Mode

Work with Prefixes

Work with Suffixes

Work with Vocabulary

O Activate different dictionaries

O Print lists from a dictionary

U Create a Topic Dictionary

L3 Organize Topic Dictionaries

0 Edit a Topic Dictionary

Checklist

© Don fohnston Incorporated



Additional Co:Writer Resources
U Help Menu
Co:Writer Getting Started

0

O User Guide

L1 Don Johnston Learning Resources on the Web
www.donjohnston.com/djlearning/cowfrm_ htm
L) Getting Started Tutorial
O Product Story
3 Standards Sheet
{1 Learning Checklist

L} Research
O Topic Dictionaries at http://donjohnston.com/downloads/downloads.htm

Checklist

X5420 9204 02/G5
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How to Create an Assignment Template Using
the Reading to Writing Wizard

1. In the Create New Assignment dialog, click

i Daty’

71072006
1M10/2006
AN072008

Flo
A Blank Document.if

Lonp-lobmpl e

2. Select the eText you want to use OR click | Browse.. | to locate eText
on your computer that is outside of the eText directory of SOLO.

3. Click[__ox 1,

1Y R0
1200
1072006
1000

03 P gracuasi E rar ooe
mb 5 Pasagraph Eniaop
B egawasg Midde Enc opn

4, Select your Outline Template.

7. Enter a brief description for your template.

8 Click[__o% ]

9. Enter a namae for the Assignment Template.

7 1o Sludents],

11. Assign your new template to students. To assign your template te

alt learners, click [ Sslect Al | To select specific learners only,
place a check in the checkbox next to the learner name{s) to

assign the template.

Click |9

12,

14. If you have Co:Writer, you are asked if you want to create and link
a Topic Dictinary.

o4 1els Ko e, Vatnotats? |

) .. .. ‘E.\e,\i%z.\.uazicm

15, Click ;. Yss

16, To return to Teacher Central, click -

Set Internet Preferences (Windows only), Preferences to Speak
Toolbar Buttons and Dialog Boxes and Test Mode Preferences in
Write:OutLoud

How to Add Locked Text
tn the Supported Reading Guide of Read:Qutloud and the Outline view
of Draft:Builder, click Insert Locked Tex
in the Draft view of Draft:Builder and Write:Outi.oud, type and
highlight the text you want to lock. Click Lock/Unlock Text ||

XE127 0305 354"



How to Add Topics/Subtopics

In the Outline tab, select the topic above where you want to add a
new subtepic.

1. ©n the toolbar, click {3 | OR in the Insert meny, select New
Subtopic. A new subtopic appears.

2, Type the text for your new subtopic.

How to Move Topics/Subtopics
1. Click the Qutline tab OR in the View menu, select Qutline.

2. Select a sublopic by pressing and holding the mouse over the
colored box,

Drag the subtopic to the place you want it, A colored line appears in
your Qutline, showing you the topic level and location where the
topic will ‘be placed when you drop it.

4. When the line is at the level to which you want to move the
subtopic, release the mouse button. Your topic is placed in the new
location and topic levet,

NOTE: Any subtopics and/or notes attached to the subtopic you
maove will be moved with that subtopic.

How to Create Notes

in the Notes view:
1. Click the Nates tab CR in the View menu, select Notes

In the Qutline panel of the Notes view, select the tapic level for the
note you want to create,

n the toolbar.

4. Type your Note OR copy and paste text from another document on
your computer.

Click | Gk to save your Note. You can see the new note in the

MNotes panel on the right.

How to Move Notes

You can move Notes gither by copying and pasting:
1. InNotes view, select the Note you want to move to a different subtopic.
2. In the Edit menu, select Cut,

3. Inthe Qutline panel, select the subtopic you want to move your
Note te.

4. in the £dit menu, select Paste. The number next to the subtopic
increases by one.

OR by dragging and dropping:
1. InNotes viaw, click and hold the mouse button down on the Note you
want to move. The Note is highlighted to show you that it is selected,
Drag the Note to the subtopic you want to move it to.

Let go of the mouse button. The number next to the topic level
increases by one.

How to Drag Notes to the Draft Panel
in Draft View

You can copy your Motes directly into Draft view using your mouse to
drag the text from your Qutline or Note to the draft.

1. Click the Draft tab, You see your Gutline and Notes in the [eft panel
of the window,

2. Click and held the mouse button down on the Note you want to
copy to your draft.

3. Drag your Note into the Draft to where you want to place the Note.

4. Let go of the mouse button 1o place your Note,

How to Use the Bibliographer Wizard

The Bibliographer Wizard gives you step-by-step directions for creating a
new bibliography reference

Qn the toolbar, click
Bibliographer.

CR in the Tools menu, select

Choose a Main Category and a subcategory for your reference.

On the bottom right abeve the Bibliographer toolbar, click
Use wizard,, |,

Select the button next to MLA or APA to sefect your
bibliography style.

Read the directions at the top of the dialog. Look at the example
shown below the directions.

In the box below the example, type the part of your reference that is
described.

to show the next direction,

Follow the directions at the top of the Bibliographer Wizard window

for each part of your reference. When you have entered all the

information required for your reference,
Finish

{ is replaced with
j to show that you are dore,

XS5327 0706 9578




Send to
Read:

Available for SOLC® users
Send o . to Next
Cutloud  Wiite:Qutloud - Sgve Print One  Sentence

Move to
End of
Door%mér

Check  Identify

Speak Spelling IDB@EBM

Write More

Link
Co:Wiiter Topic
Dictionary

Add Grow
Picture mo_mmzo: Set Om_oa

H

_.OOx_\mc:_onr
Text

Shirink
Selection

Mewk for
Delstion

§o<m to mm_m0+ m__amm Bar mmomod, ano:mo:\ m_U:onUUQ >__@3"3m2

8eginning of Sentence

Wake Up

Draft:Builder CoWriter

e Hinits

Document

If you want to see more of a panel but don't want to use the
Slide Bar, use the scroll bars at the bottom and right side of
the panel to move the view up, down, left or right without
changing the size of the panel itself.

A questioned word might be spelled phonetically (the way it
sounds) and, when spoken, sound correct, Use Check
Spelling to hear the difference between the word you typed
and the correct spelling.

Your Assignment Template may contain a word that is not in
the dictionary but it is spelled correctly. You can add this word
to the dictionary by dlicking E By doing this, the
Spell Checker will not find the word incorrect the next time
you use the Spell Checker,

uoz.@homzﬂoz

If you want the definition of a specific word, highlight the word

“ and click Dictionary.

If you do not select a word by highlighting it, the Dictionary
starts checking at the beginning of the document.

Write:Outloud includes a library of sample pictures and

“supports adding any pictures that are in .bmp, .pct, gif or

Jpg formats, Pictures are organized by categories and kept
in folders to make finding the right picture quick and easy.

To make finding new pictures (not included with
Write:QutLoud) easier, add your own pictures directly into
Wirite:QutLoud’s pictures directory. Place pictures into
existing category folders or add new category folders to fit
your spacific needs.

Text is increased to the next available font size, and pictures are
increased in size each time this command is selected.

A1 Text is decreased to the next available font size, and pictures

"~ are decreased in size each time this command is selected.

#8{ If you don't see the color you want to use, click 1.5 | 1o

e

see additional colors.
To make your text easy to read, choose colers that have good

contrast between text, background and highlight colors.

donjohnsten.com « uou.,ooo.nmao




How to Add eText How to Add an Outline
1. In the Insert menu, select Add eText

How to Increase the Text Size

You: can increase the size of the text 1o make it easier to read.
1. Highlight the text or picture you want to make farger.
2. On the toolbar, click | A%,

. 1. Click to place your cursor anywhere in the Supported
2. Inthe Add eText dialog, select the eText you want Reading Guide. (The outline will be added to the end ¢f the Guide,)

In the Qutline menu, select Add Qutline.

Click to select an Qutline Template from which you want to
add subtopics.

How to Use the Dictionary
Check word meanings in the eText with the Franklin Dicticnary.
1. Highlight 2 word in your eText,
On the toolbar, click |

In the Dictionarydialog, check definitions and <hange the word to
a different word if needed. (\L.earners may check definitions, but only
teachers can change a word in eText using the Dictionary.}

)30

H H TR Tl v € _ZE._.xv.B....G,..“l.cl
You can add up to nine eText documents. : 3 frovaratnie ot relondorprspe ol e BRS

How to Create a Note 4

1. Select the subtopic for the Note. If you are not sure where to put How to Use eHighlighters
your Note, select Unassigned Notes.
In the Insert menu. select New Note Use the Green Highlighter to create a Level 1 subtopic for your
’ : Supported Reading Guide; the Yellow Highlighter to create a Level
2 subtopic and the Red Highlighter to create a Level 3 subtopic.

In your Supported Reading Guide, click the subtopic below where
you want to place the new sublopic,

1. On the toolbar, click M

2. In your eText document, highlight the text you want to use to
create a subtopic,

Type your Note OR copy text frem one of your eText documents
and paste it into your note.

NOTE: When you double-click on ¢ subtopic in the Supported Reading
Guide, the cursor moves to that eText in the Text view,




Hide Cowriter ...,

Speak Sentence in
CoWriter Window

Undo Last Action ... e

Send Toxt T
Document

Add Prefix to
Roct Word

Select Topic
Dictionarny .

eWord Bank
Word Type

ide
¥ | More Cammands

-Ercise Lost Word

True Keys
- Add 3uffix to Root Word
- - 1 See/Change
- méx Selfings Seftings
SN;_ Topic Diclionaries
JAndentBeyetl L) Active Topic

mb:r_w:_ Equpt 2

Dictionaries List

Create New Topic
" Dictionary

- @Word Bank List

&

J]

OHNSTON

-See More Guesses,

-Turn Speech On/Off

@ m_ . Quit

L
Spasch (it Quit

Send Text to Documant

Expand sections of your Co:Writer Palette (o see and use
more Co:Writer tools.
To collapse 2 section of your Co:Writer Paletie, click 7|

Hide the Co:Writer Window and Palette, ieaving
only the wakeup button. Useful it you want your full screen
available for editing or formatting

To bring Co:Writer back, click

As you are writing 2 word, click More Guesses to show
additional word guesses for the letters you have typed.

if Flexible Spelling is turned ON, word guesses will inciude
phoneticalty-spelled word guesses,

Use Speak Sentence to hear the part of the sentence you've
written in the Co:Writer Window, In the Sentence and
Paragraph windows, this can be useful for long sentences where
part of the sentence is not visible in the Co:Writer window,

When speech is turned ON, CoWriter can do one or more of
the following: speak guesses, speak letters, words and/or the
entire sentence as you write it, and/or speak descriptions of
Co:Writer Palette buttons as you place your cursor over them,

True Keys lets you type numbers or extra punctuation into
your sentence or use keys that Co:Writer normally uses for
other purposes. When ready to go back to regular CoWriter,
press this key again.

Use Send Text ta send your words or sentence to anywhere
in the connected application without adding punctuation or
pressing Enter or Return.

Seeing and Selecting Guessed Words

Finding and choosing the word you want works the same way
whether you are using Co:Writer's Sentence, Paragraph or
Word Window.

. Type the first letter(s) of the word you want. Predicted words,

of guesses, appear in the Guesses List.

. Move and pause your cursor over the guesses Lo hear them

spoken aloud (if the speech option is turmed ON in your Settings).

To select the word you want, click the guess with the mouse
OR
Type the number in front of the guess (if numbers are showing)
CR
Use the Down Arrow to step through the guesses. Press the
Spacebar to select the word,

Thefe ara severslw

donjohnston.com = 800.999.4650



Writer®

Getting Started with Co:Writer SE . Using the eWord Bank
" . . ) 6. Click . The Co:Wiriter Palette Window and Guesses
Co:Writer is a wrlting assistant designed to be used together with : When you have one or more CosWriter Topic Dictlonaries selected, a

another application. The first time you use Co:Writer, follow these Window appear. list of key words from those dictionaries appears in the eWord Bank.
simple steps: 7. Bedin typing in your Co:Writer Guesses Window. You can choose to show Names & Nouns, Verbs or Adjectives listed
= in your eWord Bank at any one time.
1, Double-click on your Windows desktop or click @ on your e
Macintosh dock = Selecting a Topic Dictionary 1. Click {Hamitem_ ~{ at the bottom of the Co:Writer Palette
- . Use one or more of Co:Writer’s Toplc Dictionaries to get quick access Window. .
2, Click | Newwrier.. | and Q.ﬂn your name into the Enter Name to the topic- and genre-specific vocabulary you :,mma. From the drap down list, select the type of words yau

dialog. Then, click {_o¢ | 1. On the Co:Writer Patette, click The Select Topic want to view,
. Dictionaries n_m_om appears. ﬂs_ ns_oa wuzx

-r you Svough i preoasy ol seting Lo Cawilu
actordng 10 yma proferencat...

E Achen i 10 -

: Use the scrall bar at the right of the eWord Bank to view
3. Folaw the directions in the Co:Writer Wizard to create a New ail the words.
Writer flle that meets YOUR individual needs, In the Categorles panel, select a n.wﬁmm.uq_

4. When you have set up your New Writer fife using the Wizard, in the Topics panel, setect one or more Topic Dictionaries.
cick|_rr_|

if you want to select Topic Dictionaries from additional categories,
5. Find and launch your favorite word processing program as you repeat steps 2 and 3
would normally, when using it without Co:Writer.

Click £..9% ] to close the dialog and begin using the words in
your selected Topic Dictionaries as you write.




Locked Text

Selected Note ===t

_S_O LO | Siccors prnzon

T Tips for using SOLO™ OQutlines Bridges

: . ¢ Subtopics and Locked Text are created in Teacher mode can't be
Rainforest
\Vhat do you think of when you...
| Scan the aticle and look for a... + Locked text can be hidden using the view menu but not deleted.
“What | Already Know
“#Z= When | think of a rainforest |...
L Click on "New Words.” After you... under the subtapic.

- For each new word in your outline.... e Add new subtopics using the highlighter pens. Select the topic

modified in Student mode.

Notes « Subtopics can be deleted but doing so will delete all information

Hint: Move the note box over to that it will go with before highlighting otherwise the information

Subtopics -_;_-: " New Words
‘ "Conservation” will go fo the end of the outline.
Conservation means a.. * Use nofes to type new information and use highlighter pens to get
“species”

Notes == information from your document into the outline.

Z= Species means...
“ropical” » You can also add new notes, in chronological arder by using the

== Tropical means... o
Insert Note button within an open note.

-+ Now read the article. After you...
- Highlight the words that describe_.

What are Rainforests? ¢ If it looks like a sentence is cut of f, click on the box to expand it.
Description of rainforests

* You can copy and paste information from the document into notes.

* The speech buttons can be used anywhere in the outline.
« Double-click on notes to type new information.
» Start a new outline using Add Outline from the Outline menu or

Control + Shift + O,

S S
) ' Add text to the outline using highlighter pens. Each colour reflects a different level in the outline

(green - level 1 yellow - level 2; pink - level 3). You can't type over text added with highlighters. Te change the
text use the re-highlight button. The text will have quotation marks to show that it comes from an existing

decument.
Green (Alt + 6) Red (Alt + R) Pink (Alt + D) Re-Highlight (Alt + H)

= Use the New Note butfan to add new notes in the outline. You must be on a topic level {not a note)te add a

new hote.
Control + Return

Use the arrow buttons to move the topics to a different level (green, yellow, pink) in the outline. {Control
+ Alt + Left) (Control + Alt + Right), Move topics to a different place in the outline by clicking and dragging, using
(Conitrol + Shift + Up) (Control + Shift + Down) or the Qutline menu controls. A coloured bar will show it's
placement in the outline, All subtopics and notes will move with topics.

" lwert Outios Jext Spesth Toos We

_, Showjtids Locked Text 645
Stowfride Toobar - CrkAke; Hide or show locked text with Show/Hide Locked text or Alt +5
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Highlighting while Reading in SOLO™

The use of highlighters is a strategy that encourages students to read more actively by working with the
material that they are reading. Highlighters can also be used to help student’s organize their reading. For
example, they can use highlighters to mark all of the main and supporting ideas in a document before
reading for detail.

RWNe

o o

A In SOLO™ each colour highlighter reflects a different level in the outline.
Green - level |
Yellow - levet 2
Pink - level 3
Each additional fevel will be assigned a different colour.

- You can't type over text added with highlighters. To change the text, use the re-highlight
button, The text will have quotation marks to show that it comes from an existing document.

Each highlighter has a keyboard equivalent.
Green (Alt + 5)Red (Al+ + R) Pink (Alt + D) Re- Highlight (Alt + H)

Sign-in as Learner 1.

Open material to read in Read:Qutloud®,

Notice the blank outline on the right hand-side.

There are 3 highlighters in the toolbar at the top. Think about the reading material and the task.
Decide how you want fo use the highlighters for that task.

Now try using the highlighters.

An outline will be made on the right-hand side of the screen from your highlighters. You can work
with the information in this outline (delete points and move items to different levels or places in
the outline). ‘

Refer to the handout Tips for using SOLO™ outlines for help with using the features of the outline.

Save your work and/or print. When printing you have the option of printing the
outline only, the outline with the text, locked text and the bibliographer.

You can alse take the outline created from your highlights into Draft:Builder® to
build a 1°" draft of a writing assignment or directly into Write:Outloud® to create

a finished project. Do this using the Sendbuttons in the toolbar.

Send buttons

Draft:Builder® Write:Outloud® Read:Cutloud®

Bridges Canada September 2005 lofl
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 Bridges Creating SOLO™ Assignments Using
The Reading to Writing Wizard

This tutorial will teach you how to use the Reading to Writing Wizard to quickly create an assignment
for a student, The assignment will begin in Read:Outloud® using outlines for learning supports and then
move To Write:Outloud® for the writing component of the assignment. A Co:Writer® fopic dictionary

will be linked to the assignment.

Our topic for this tutorial will be ocean life, specifically the giant pacific octopus. Students will use
information from the National Zoo to learn about ocean life. They will use the KWRL outline to promote
strategic comprehension. Before reading, they will complete the "What I know" and "What I want to

" Know" sections of the outline. They will use content provided by the teacher Yo research the topic and
complete *“What I learned”. They will summarize, revise and publish in Write:Outloud® using a
Co:Writer® topic dictionary with topic specific vocabulary.

The website reference is http://nafionalzoo.si.edu/

Section 1: Creating a Co:Writer Topic Dictionary
We will begin by creating a Co:Writer® topic dictionary; signed-in as a feacher. This dictionary will be
created from an eText file containing vocabulary from the website the student will use for research.

1. Launch Co:Writer® from the deskiop. e

2. Sign Inas a teacher; password "School”.

w

You will see the Co:Writer® teacher palette.
4. Choose Create from the Topic Dictionaries area.

Bridges Canada www.bridges-canada.com 1-800-353-1107 10f8
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Eﬂéges Creating SOLO™ Assignments Using
The Reading to Writing Wizard

5. Name the topic dictionary "giant pacific octopus”,

gt
J( Elements

6. Choose Select File....

7. Navigate to the desktop; workshop files folder; eText files and
choose the file "giant pacific octopus text”,
The text from the file will be inserted into the window.

8. Choose Create Topic Dictionary.
9. You will see the words from the file being imported in the
Co:Writer® window. '

10. Select Manage from the Teacher Options palette.

11. Select the Organize tab. Your new topic dictionary will be under the Not Filed category. Click
and drag to move it into the Science and Nature folder.

12. Select the View/Edit tab to see the words in the dictionary.

13. Choose Ediit Dictionary to make changes to the dictionary.

14. When finished select OK and then Quit 1o leave Co:Writer®.

!

Bridges Canada www.bridges-canada.com 1-800-353-1107 20of§
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' Brldges Creating SOLO™ Assignments Using
The Reading to Writing Wizard

Section 2: Creating an Assighment

A. Teacher Sign In

1. Double-click on the SOLO icon Bhon your desktop to launch SOLO

2. Choose Teacher Sign In..

tearner 1
iLearner 2
Pogay
iscott

3. Select the drop down menu, choose teacher and enter the password
"school'.

4 Select OK.
Yu should now be in Teacher Central

.Bridges 30f8
October 2005

Canada www.bridges-canada.com 1-800-353-1107




iy

@tj‘gges - Creating SOLO™ Assignments Using
The Reading to Writing Wizard

B. Start New Assignment with Reading to Writing Wizard

- New Assignment Template... 1

1. Select New Assignment Template.k

2. Choose Open Reading to Wrifmg Wizard.

Opan the Reading To

i\ prna AR

Long Joha StalTofrish aTst if
Rainlores &7 ottt
Saturn eTex il

4. Choose the file iant Pacific Octopus (word version).

5. You will be prompted to add an Qutline Template.
Choose KWRL Draft:Builder.opt Template and select
oK. '

Bridges Canada www.bridges-canada.com 1-800-353-1107 40f8
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The Reading to Writing Wizard

6. You will be asked to link To a Co:Writer® topic dictionary.
Select Ves.

7. Choose the giant pacific octgpus topic dictionary.

3 Al ].'o"ms . E}glpn;qptxd, g

| Ackve Topics bansitional words

1 My Topics o ;
| ek, . regen 8
1 Famous Peaple C] Quls in the Family i;
i} Geography & Travel £ Pionees Léa i
-] Histoy

i| Helidays

] Just fox Fun

.| Lieiatwe

-1 Music & Art
:| Science & Nature

-1 Spoits

1 Types of Wilting

‘1 _S0L0 Tapics

1 _Statto-Finish Titles

B elements - elements by 1 -

: Read: Outloud® will launch with the KWRL outline on the left.

C. Adding Content Pages in Read:Outloud
We will now add content from the Internet for the student to use for their research.

PN L

1. Select the Read:Outloud® wakeup button from the toolbar.

2. Read:Outloud® will open with the KWRL outline on the right-hand side and the octopus file on the

left.

Select the Web tab.

4, Type in the web address http://nationalzoo.si.edu/ and select Go. Choose animals efc., choose
animal cams and choose octopus cam.

w

5. Return o the eText fab so that it is the main page.
6. Savel
Bridges Canada www.bridges~canada.com 1-800-353-1107 Sof8
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Brldges Creating SOLO™ Assignments Using
| The Reading to Writing Wizard

D. Moadifying the Draft:Builder® KWRL Outline

You are now ready to modify the KWRL template. You will modify the instructions and format of the
outline to suit the needs of students who require a simplified outline with more direction. Although the
student is only using Read:Outloud® and Write:Qutloud® for this activity, we will modify the reading
outline in Draft:Builder®, This is because there is more flexibility for working with outlines in
Draft:Builder®.

1. Click on the send to Draft:Builder button. You will be asked to save the assignment before
proceeding.

2. You will be prompted to enter an assignment description. Write a
description of your assignment. Include a statement about the type of
activity.

w

Name the assignment "the giant pacific octopus”.
4. Click the Assign to Students button. Make sure that it is assigned
to Learner 1.
- B, Select Save.

6. Click on the My Topic line. Rename this " The &iant —
Pacific Octopus”.
7. Delete the following instruction boxes and topics:
a. "Write your topic in the green subtopic below”
b. My Topic:
c. "Before you read about something new, fill in the.”

ORE you iead apoutzé.:omem_ing riew, fillin t
OW:(of-thiflk Friow)

8. Click on the green fopic “What I know (or think I know) and insert

5 new instruction boxes using the Insert Locked Text button. 7 il
The instruction boxes will be inserted above the topic. - fg’at

r .

TSR What | KNGV (or think | know)
i Fknow... ’

‘% I-kﬁow...

| lvow...

Bridges Canada www.bridges-canada.com 1-800-353-1107 6 of 8
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Bndges Creating SOLO™ Assignments Using
The Reading to Writing Wizard

9. Write the following instructions into each of those boxes.
a. Learn about the Giant Pacific Octopus.
b. Begin by writing what you already know about the octopus. Click on the yellow "I know" boxes
to write.
¢. Write 3 questions that you want o answer. Click on the yellow "Question” baxes to write.
d. List your resources. One of those resources must be hitp://nationalzoo si.edu/
e. Go to Read:Qutloud® o research your questions.

10. Click on the first yellow I know subtopic.
11, Select the Notes tab. [ TS (m) T -

12. Click the Notes button 3 times. % Add notes for the
remaining "I know" subtopics. This will give the student a
place to type what they know in Read:Outloud.

o
+7{0) Cuextion 1:
EE(0YWhM ) heomed .
) (e ption 2t

Note: The "notes” only show in note view in Draft:Builder®,
however, once the outline is viewed in Read:Outloud® the
tes will appear directly underneath the subtopics.

A i | trard...
CIE 0 What RESOURCES vl | yse?
i ot

P
4]

¥yhiot § LEARNED

2t What | WANT to find out

13. Click Question 1and select the New Subtopic button - from the
toolbar.
14, Select the Indent button to make it pink. Type “What I learned..”.

15. Do this under each of the 3 Questions.

{% - If you student requires exira support you could add the questions for
' them. 1) Where does the giant pacific octopus live? 2) What does the giant pacn‘lc oc’ropus eat? 3)
How does it protect itself?

16. Scroll down to the bottom of the outline. Click on “Now read about your topic” delete this text and
replace it with New Vocabulary.
17. Delete everything after this.

Bridges Canada www.bridges-canada.com 1-800-353-1107 7of8
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E. Add Writing Guides in Write:Outloud®
1. Select the Write: Outloud® wakeup button.

2. Write:Outloud® will open with the KWRL outline on the right-hand side.

3. Type the following instruction into Write:Outloud®.
1) Give your topic a title, :
2} Write an Introductory Sentence.
3) Write 1 paragraph summarizing what you learned about the giant pacific octopus.
4) Use the following transition words to tie your summary together,

in addition to  furthermore however therefore fo conclude  during

Save and try it out
1. Go to the File menu and select Save.
2. Close all files using File > Close or the red "X to return to Teacher Central.

3. Quitout of Teacher Central.

4. Sign Inas Learner 1.
5. Find the assignment that you just created.

6. Select the Co:Wiiter wakeup button.

7. Try out the assignment

Bridges Canada www.bridges-canada.com 1-800-353-1107 . gof 8
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k. il Know

W: What | Want to Know

R: What Resources/Research will 1 use
L: What | Learned

A learning strategy developed by Karen Ogle (1986) to help students prepare for reading, to read more
actively and to communicate their learning. KWRL charts can be used prior to reading activities or whole
units of study. They can be implemented with a group of students or by individual students. The KWRL
chart helps students to set and monitor their learning goals.

1. Sign-inas Learner 1.

2. Select New. (e | Choose DrafF:Builder®.

3. Select KWRL.opt and then select OK.

Rt e CUA ¢ b swdwwie T

Lo )

4. Decide on a topic that you would like to research. Enter your topic title into the title line.
5. Read the 15 two locked text boxes and then complete the sections
a. What I KNOW (or think I know)
b. What I WANT to find outf, and
c. What RESOURCES I will use.
If you need help working with the outline, refer to the handout Tips for using SOLO™
outlines.

6. Send to Read:Outloud® using the send buttons in your toolbar.

@ g "2\'\} ,-z_:z;"
ﬂar f\—:u" '—__L:,f'

R

Draft:Builder® Write:OutlLoud® Read:Outloud®

7. Open the content that you will use for your research. Refer to the Ma-naging Content handout
if necessary.

Bridges Canada 09/2005 www _bridges-canada_com 1-800-353-1107 1of 2
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©  VWhat | LEARNED
! learned...

8. Click on the green point, What I ARNED.

9. Use the yellow highlighter to select new things that Youjlearned from the document. These
will be added under I fearned.. in the outline.

Some tips about highlighting:

- Select the text that you want to highlight first by clicking and dragging {g:;-;:mf:;m . "
over it “' wheiteamg

- Select the highlighter from the toolbar in the colour that you want. It will Enlwr OO
be added to the blank outline. b nttn woedea”

- Select the more text and choose q highlight colour. ekt

- Everything you highlight after this will be added underneath the last Dkl
highlight. vt ot

- Delete a highlight by clicking on the note in the outline (it will turn grey) Whﬂ
and select the delete button, v, s b oo 10

- New highlights are added underneath selected notes in the outline. hen you v e ot ..

- Move notes in the up or down in the outline by clicking and dragging or
change their level (colour) in the outline using the left/right arrow keys in the
keyboard.

10. Once finished you can:
a. Save and/or Print (print the outline and text or Jjust the
outline).
b. Go to Write:Outloud®to write more, revise and publish
your research,

i : ﬂm el

AN

. Draft:Builder® Write:iquoud® Read:Outloud®

Bridges Canada 09/2005 www.bridges-canada.com 1-800-353-1107 2 of 2
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Using the KWRL Strategy in Read:Outloud®

What is Read:Outloud®?

Read:Outloud® is a text reader that supports students with modeling, scaffolding and research-based
reading strategies. Read:Outloud® has Supported Reading Guides to model effective reading strategies
for different genres of reading. Students use these guides to help connect reading and writing.
eHighlighters are available as a tool for identifying main ideas, supporting details in the text as well as
implementing other proven active reading strategies. Teachers can create assignments with pre-
selected Reading Guides, modified presentation of content and specific reading preferences to meet
individual student’s needs.

What is KWRL?

K: What I Know

W: What T Want to Know

R: What Resources/Research will T use
L: What I Learned

A learning strategy developed by Karen Ogle (1986) to help students prepare for reading, To read more
actively and to communicate their learning. KWRL charts can be used prior to reading activities or whole
units of study. They can be implemented with a group of students or by individual students. The KWRL
chart helps students to set and monitor their learning goals.

This tutorial will fead you through using the KWRL chart in Read:Outloud®.

A. Opening a Saved E-Text file

1. Sign-in as a Student (Learner 1)

2. Select New and select Read:Outloud® or if you are working in another
application such as Draft:Builder®, select the Send to Read:Outloud
button in the toolbar.

3. The Add eText box will appear. Select Browse from the Add eText
dialogue box.

4. Find the eText file that you are working with. Click on it and select Open.
It will open inte Read:Outloud®.

Bridges Canada 05/2006 www_bridges-canada.com 1-800-353-1107 lof 6
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Using the KWRL Strategy in Read:Outloud®

B. Using the Formatting Tools

The student can increase or decrease the size of the text using the Grow Selection or Shrink

1.

Selection buﬂons

i

Bridges

| in the toolbar. They can't perform any other edmng functions.

The student can also use the sfider bar between the con‘re.n’r area and the outline to view more or

less of the content or the outline. Ther'e is a slider buh‘an
same function.

Swmeioin | Wb

Saturn

Content : >
i Satuin is sometimes celled "The Jewel of the Solar System.” ltisa 2

fascinating planet thal is nothing like our ovn. Humans have been gi. %

up 3t Saturn and wondering about it for thausands of years. :

dz ot

Hase are some fun facts about the Ringed Planal,
- Satwinis huge . Itis the second latgest plonet in o Solar Syster. ¢
Jupite: is bigger_ If you could line them up, more than nine Earths w.
across Satun.
H - Unlike Earth, Saturn is made mostty of hydrogen and helium. While
3 heavier materials in he core. Saturn has no surface on which you cr'
; stand.

o o SR TR

- its beautiful ings are not solid eiher. They are made up of pam‘cles"
dust and rock. :

_i_i

BEFOHEyou Tiead abou‘!

2 what | KNOW cor think | know

Ti’?}i 1 know...
-—

22 I hnow...

Tw’“ 15now...

‘BEFORE you read, witd your....

5 WWhat | WANT to find out
Tw»(}uesison 1

Twcneshon 2

“in the toolbar that performs the

.- Reading outline

Slider bar

size and colour for text in the outline.

€. Reading Tools

Using the Reading Buttons
1. Choose the Read button |

2. Try the Read Paragraph button

3. You can alse choose Read All

Bridges Canada 05/2006 -

3. The Text menu applies to the outline not o the e-text document. You can change the font style,

rom the toalbar or use Cfrf + T. Read the title and a few sentences.

What did you notice about the reading? How did it sound? How did you make it read from sentence

to sentence?

or Alt + R

www . bridyes-canada.com 1-800-353-1107
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Using the KWRL Strategy in Read:Outloud®

4. Notice that once you select the Read, Read Paragraph or Read All button they turn into a Sfop

Cr

Reading button %‘{ ' use this or Alt + R at any time to stop reading.

5. Try the Repeat buttion “or Ctrl + R Can you repeat as many times as you like? How does it

repeat the information?

Reading Options
1. The following reading options are found under the "Speech Menu” in the menu bar. Take a minute o
explore these and think about how they would apply to the reading needs of different students.
a. Turn Speech On/Off (toggle). |
b. Speak Toolbar and Dialogue boxes.
c. Highlight word by word.

2. Select the Speech menu and choase Voice Settings. Here you can choose a new voice and set rate,
pitch and volume for that vaice. To try a new voice click on the voice and select OK. Explore 2 new
voices at dif ferent reading speeds.

a. Why would you choose different voices?

b. Why would you choose different reading speeds?

Dictionary Tool
1. Double-click on a word to select it.

2. Choose the Dictionary bution from the toclbar, =
3. The Dictionary dialogue box will open. Click on the speaker

button: " to hear the word in a sentence.
4. Click the speaker beside Definitfon to hear the definition of the
word.
5. Choose a suggested change and select the speaker buttonto
hear it. This function would be useful in show homonyms for
words.

6. At any time, you can click the stop speech button:

7. Select OKwhen you are finished. Look up some more words from the document.

D. Working with the Outline and Highlighters
We created a KWRL outline in Draft:Builder® and have sent it to Read;Ou‘roudf@. Let's take a minute
and explore the outline in Read:Outloud®.

Bridges Canada 05/2006 www bridges-canada.com 1-800-353-1107 Jof 6
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Using the KWRL Strategy in Read:Outloud®

Working with the Qutline

1. Take a look at the information that you added in Draft:Builder® (what I know, what T want to know)
Click on some of these points and use the speaker button to read them.

2. Click on the locked text instruction ‘row read about your topic”. Use the read button to read this
instruction,

3. Read the next 2 instructions.

4. Now, we have read our instructions and are ready to do our work. If the student prefers to work
without the instructions in view they can turn off the instructions. Select the view smenu and select
show/hide locked text (alt + 5). The locked text will be hidden and can be brought back when
needed.

5. The student can add information about what they learned in 2 p!aces

a. Under What I learned or;
b. Directly under the questions that they have written.

Working with the Highlighters

The use of highlighters is a strategy that encourages students to read more actively by interactirig with-
the material that they are reading. It is also a way that students can take notes from material that
they are reading. '

The highlighters in SOLO work in a very structured way. You are given 3 colours to work with (green,
yellow and pink). Below is a quick description of how they are structured.

In SOLO™ each colour highlighter reflects a different topic levels in the outline. Once a green
highlighter is used or clicked on, the yellow highlighter will be available for the next level of information. Once the
yellow hlghllghTer is used or clicked on in the outline, the pink highlighter will be available. This helps student to
create an organized outline.

reen - level 1
-level 2

= mk level 3

& You can't type over text added with highlighters. To change the text, use the re-highlight button,
Each highlighter has a keyboard equivalent.
Green (Alt + G) Red (Alt + R) Pink {(Alt + D) Re-Highlight (Al+ + H)

1. Click on the first Question that is written under " What I want to learn”. This is yellow so only the
pink highlighter will be available to add more information.
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Using the KWRL Strategy in Read:Outloud®

2. Find an answer to the first question. Click and drag to select the answer and then click the pink
highlighter pen in the toolbar. The information will be added to the outline. You can add more
information for this question or continue on with the remaining questions.

3. Highlighting in the document and the outline is directly related. Yo delete highlighting in the
document you delete that point in the outline. Delete points in the outline by clicking on them once
and selecting the delete button on the keyboard.

4. You can also double-click on a point in the outline and it will take you to that highlighted point in the
document. :

Adding Notes

The student might need to type their own notes into the cutline. Why? Maybe there isnt a clearly
stated main idea in the paragraph and they need to write their own: maybe they want to synthesize the
main idea into a more clearly stated phrase, or maybe they want to leave themselves a note for
brainstorming an idea for a paper. Let's use it to add a definition of a new word to the outline.

They also used embalming to keep the body forever,

1. Select a word i the document by double-clicking on it. (Make sure your
highlighter is turned off first).

2. Select the Definition button in the toolbar.

3. Select the Copy button to copy the definition.

4. Select unassigned notes in the outline.

5. Choose the New Note butto : from the toolbar. A blank note will
be inserted under the selected item and a note window will open,

6. Select the Paste button.

7. Select OK when finished.

The note with definition will be added to the outlinel

E. Using the Internet for Research

Read:Outloud® allows students to launch a web browser to do online research and reading. Students are

able to use the read tools, definition buttons, and highlighters while reading online. Highlighting while

reading does not work while reading online. The student can "capture” a webpage which converts it to a

text file. A captured webpage does have highlighting while reading.

The student can get to a webpage in a number of different ways:

1. The student can type the website address into the address bar of the web tab.

2 The teacher can work with the student to add a website address to the outline (under what
resources will T use) and then the student can click and drag the address from the outline into the
address bar of the web fab.

3. The teacher can add web addresses to the e-text document that the student is working with and the
student does a control + click to access the website information.

Bridges Canada 05/2006 www. bridges-canada_com 1-800-353-1107 50f 6
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Using the KWRL Strategy in Read:Outloud®

For this futorial we have created hyper-links to WebPages that the student will use for research. Using
hyperlinks embedded in the e-text saves the student from having to copy in lengthy website addresses
and also saves them from having to follow complicated links.

1. Scroll to the bottom of the e-text file. There will be list of hyper-links.

2. Control + click on the first hyper-link. It will take you to a website. You can now use the reading
tools and highlighters to add more information to your outline.

3. Return to the original document using the first tab.

4. Control + click on the next hyper-link on the list. It will take you to a different website. You can
continue to do your research. All tabs will remain open. The student can continue opening tabs
and doing research.

Saving
1. Go to the File menu and select Save. You will be asked to give the file a
hame. Select Save.

2. The name of your file will change in the title bar and in the title of the 7 pyramid main ideas

outline. 5 "tomb was called a...

3. The file will be saved to Learner 1 > My Work. %32 "final resting place,”

Print
You have the option to print the text only, the text with the outline or the outline only. Go Yo Print
under the File menu and explore these options. Select Cancel - rather than print for this activity.
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e KWRL Strategy

K: What I Know

W: What I Want to Know

R: What Resources/Research will I use

L: What I Learned

A learning strategy developed by Karen Ogle (1986) to help students prepare for reading, to read more
actively and to communicate their learning. KWRL charts can be used prior to reading activities or whole
units of study. They can be implemented with a group of students or by individual students. The KWRL

chart helps students to set and menitor their learning goals.

A bit about Draft:Builder®

Draft:Builder® is an organizational toot that provides students with tools for writing outlines, making
notes and writing their 1 draft. The drafts can be viewed in a map, tree or linear view. They can be
printed in the different views or exported into Write:QutLoud® for final publishing or into
Read:Outloud® as study or reading outlines. Draft:Builder® comes with a variety of templates for

different genres of writing.

pening the KWRL Template

1. Launch SOLO
2 Select Learner 1 from the Sign-In window. You will enfer info Student Central.

3. Select New, |5 N

& Haculine

4. Select Draft:Builder®: e -
5. Choose the "KWRL.draftbuilder” template from the Add an Ouﬂlhg/WEEE
box. ... i i o
Notice the description of the template in the lower right-hand corner. ’ ;;:';mr ‘
6. Anuntitled Draft:Builder® template will open. o wo e R
chuaraclors in your sy 4a0
I( — 2 Mwﬂnﬂ!lmﬁ-:ﬂ ol

lof' 5
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KWRL using Draf+:Builder® Bridges

Viewing the Template

1. Try the different methods of viewing the template.

o Qutline viewwith a freeis the default setting. You can also choose to view the outline with
the concept map by clicking on the concept radio button. § MopVien & Tree O Concet
=7

b. The sfide bar(add picture) or button (add picture) L will allow you to change the size of

the outline view in comparison o the concept map or iree.
c. The Increase or Decrease font buttons change the fant size of the outline and the map.
d. The Set Colours button changes the background, text and selection colour.

Al o ph

Reading Locked Text and Topics

Locked text is text that the student can't modify or delete. It has a light yellow box over it. Locked -
text boxes will only show one line of text at time to keep the outline from getting too busy. If thereis
more than one line of locked fext the text box will expand when it is selected. Locked Text is in
existing outline templates or can be added by teachers into new or existing outline templates.

Topics and Subtopics are points in the outline. They are colour coded (green, yellow, pink, blue,
orange...) to reflect different levels in the outline. Topics are always green; subtopics fall underneath
topics. Topics and subtopics can be read, writfen info, moved, added and deleted.

1 Click the first locked text box. (“Write your topic in the green jThedcsan
. : i - Subtopic
SUbTOPIC b€|OW). . \l=-\f\|‘|ite your tapic in the green subtopic befow. -
2. Select the Speakbutton W 4o read it. [ The Giant Pacific Octopus -
2. Select the View menu and select Show/Hide Locked Text, "BEF“?;i :':;Oe:,: ;‘::'m";:::;g new il the.
Once the student is finished with the instructions they can 1 I know..
hide them for a cleaner view of the oufline. ‘ I'é:iﬁ
3. Click on the TOPICS and SUb?OPiCS and use the speaker button L BEFORE you read. think of 2 or 3 questions you have...
to read them T8  What ! WANT to find out
’ : Question 1:
4. Click on the Notes tab. This is where the student will add Question 2:
Cuastion 3:

notes to each point in the outline.

20f 5
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(WRL using DrafBuilder® Bridges

5 Utk Hotes Draft

Notice that the points in the outline have "0" notes attached. y
Hatm Drah
2The Ocean
" {0)Subtopic
(G} The Giant Pacific Octopus
{0)What | KNOW (or think | know)
{0} knowr...
(O} know...
O3l know...
{0)\What | WANT to find out
{0y Queastion 1:
{1 Question 2:
{0} Question 3:
- (O}What RESOURCES will Luse?
) {0)Rescirce 1:
{0)Rescurce 2:
(0}Resowrce 3!
fﬁ {O}What | LEARNED

{0} fanmeed..
{0} leaitved...
0} amed...

6. Click on the Drafttab. This is where the student will compose their final draft.

| Duine Notes } Draft |

“1sing the KWRL Template

i Return to the Qutfine view. We will begin by adding a topic name and information info the "what I
know and what I want to know sections”.

Click on the top “my topic”. Type “ocean life”.

Click on the first green Subtopic button. Use the delefe key on the keyboard to delete it.
Click on the second green *my topic” button and type ° the giant pacific octopus’.

Click on the yellow sub-topic *I know". Write “an octopus lives in the ocean”. Write 3 more
things that you know about the octopus. ' '

Use the enter key or the new subtopic button to add another question to the list.

o - F

f. Click on the yellow sub-topic "Question 1". Type "where does it live”
g. Click on the 2" yellow sub-topic "Question 2" type "how big is if?”
h
i.

an oTe

®

. Click on the 3™ question and type "What does it eat?”
Add 2 more subtfopics and write 2 more questions.

2. Tips for working with Topics and Subtopics
a. Delete or type text in a subtopic by clicking on the subtopic so a cursor appears. Place the
cursor at the end of the text and use your backspace key or click on the text so that cursor
appears and then select delete (if the topic line is grey you will delete your whole topic line).

Smairt

text : whole topic line

September 2005 www.bridges-canada.com 1 -800-353-1107 3of 5
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KWRL using Draf+:Builder® Bridges

b. Move topics up or down/left or right in the outline by clicking and dragging them up and down
or by using the arrows in the tootbar. A coloured line will indicate the topic's level in the a

outline.

3. Add the thenationalzoo.com and library under resources that I will use.

" Notes ‘ Dick

4. Select the Notestab. . . %% . . .
a. Click on one of the What I Know subtopics.

on (O % N B
b. Add a note to the subtopic by clicking on the New Note button. \__/ '

Write a sentence about the subtopic into the Aofe window. —_
Try using the speech and spell check options within the notes

window.
e. Add notes for more of the outline. (Tip, you can add more notes by
clicking on the New Note button in the note window).

1
(2] ‘l'
New note button = -

Speech & Spell Lu’rtor :

a0

5. Select the Draff tab. You will see the outline with notes underneath each point in the outline.
a. Click on the notes and drag them over to the writing window. Organize your notes, add to

them or reorganize them in the writing window.

- Ongce upoh & time there was a really tewific family. The

T smart
N main character s me. | reolly Rke to do creative things. |
N | think thet § am pretdy smert. | was areally fce to wiite, peint and drew. | think that | am prefty smert.
good student and bke to read slot. *was a really good student snd ke to read slot.
BE | st think that | coult leam motse. c?_?

T- T organized
E Many people say thet | sm organized. so L.

b. Try using some of the writing supports such as:

» Speak button :“a] to listen to the draft for editing. J’;”’;Z.."f” e
» Spell checker Yol ey e
» Dictionary ‘ o il e

o Cue misspelling (auditory cue for misspelled words).
These can be found in the Tools menu or the toolbar {cue misspelling is not in the

toolbar). _
o Co:Writer® word prediction. Open this by clicking on the Co:Writer® button in

the toolbar et ]

September 2005 www.bridges-canada.com 1-800-353-1107 4of 5
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KWRL using Draft:Builder®

6. Explore the Print Options. You are able to print the outline, draft, map or notes
or any combination of these.

You can also send the outline that you created directly into Write:OutLoud® or
Read:Outloud® using the Send buttons in the toolbar.

Send buttons

Draft:Builder® Write:Outboud® Read:Outloud®

-

50f 5
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oifferent ways to get content into SOLO™:

SOLO™ assignment templates

SOLO™ sample E-text

Your own E-Text or saved webpages brought into SOLO™ (retains graphics, no links)

Web-sites - read on-line through SOLO™ (no highlighting as you read, retains graphics and links)
‘Web-sites - capture websites to read off-line (highlights as you read and allows for formatting text,
might not capture dll pictures but you can insert pictures.)

B Scan material info OCR software (Omni-page), save as RTF and bring into SOLO™ as E-text.

999V

SOLO™ Assignment Templates

Learner 1 - open Assignment Template - Check previews - Open template - Try it - Close

1. Signin as Learner 1 to enter Student Central. Document
2. Click to open the Assignment Templates folder to  {_yhssgnment Templates
view the sample SOLO™ assignments. _ gl
3. Click on different assignments o see - ;'B;‘jx‘da"d Characterasn
. R . =Ty
previews in the side box. _ Favorke Spor 5.dis
: : : Hal 4.6
4. Choose an cxssllgnme:nf (double click). Try it out. e e Balapagos s
5. Close it by using File > Close or the red close button Mush: Videus 7.dfs
. . . : My Town Is Best.dis
v the top right corner. You will return to Student Central. Thankegiving 2 dis
 Stat-Tofinsh

Note: Assignments include a variety of materials depending on the task and requirements. An assignment
might include locked reading material, supported reading guides, pre-reading questions, pictures, or diagrams.
An assignment can open in Read:Outioud®, Write:Outloud or Draft:Builder depending on the purpose of the
assignment. Teachers create assignments for students in Teacher Central and save them into Assignment
Templates for students To use. When students finish assignments they are saved into My Work.

SOLO™ Sample E-Text
New - Read:Outloud® - Select eText - Read - Close

1. Click on 'New. B oo é"?;r
2. Choose Read:Outloud®. e paatd i
3. You will see a list of sample e-text provided by _

DonJohnston. Any e-text that you add will also appear -

here.
4. Choose one to read by clicking on it and sefecting OK.
5. Close it when you are finished. ‘ )

| (=]

Bridges Canada :
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SOLO™: Managing Content Bridges

Importing your own E-Text

Website - Save eText - teacher sign-in - browse - open - edit - save - assign!

Students can open eText to read but can't modify or format it. Teachers can open eText, format it for different
learning needs, and assign it to students to read.

1. Go to a web-site with text that you want to use.
2. Select File > Save As. Give the e-text a File name. You can change the file type to Textif you want
" only the text and no graphics or save it as a web page if you want to retain the graphics. Save it toa
location that you will remember (e.g. a folder labeled my etext).
3. Exit out of the internet.
4, Signon as a Teacher (password - school).

5. Choose New Assignment Template. . Newfssighment Template...

6. Choose Open Blank and choose Read:Outloud®®.

If you are already in
S0L0 go to Insert - add
eText to bring in your
own efext.

.Opsn a SAVED
Azslgnmen Templace

’ -
| OpenaBILANK
i A3 $igivment Template

<panths Reading To
Wriking WIZARD

=]

7. Select Browse from the Add eText dialogue box.

8. Find the eText file that you just saved. Click on it and select Open It will open into Read:Outloud®.

9. .Format the text to for the student.

10. Select Fife > Save. You will be prompted to write a description of your fempla're give it a name and
assign it to a student or learner. Select the Save button once you are finished with these steps.

Write description Choose students

plutc Descnplinn . \MJ. ] Name Gt’ld ﬂSSign

{ Sebcl;ﬂ.l. - “De‘;de;!#l
) |

priages vanaoua
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SOLO™: Manqging Content Bridges

Reading the Internet: Online
Student Log-in -New - Read:Outloud® - Cancel ~ Type internet address - Use read buttons

¥ Hong 008 (Torherl JURILIE CoROMOMAT . . . ou i b e v e e Cn eotoeets dhtt it e <

Log-in as a student (Learner 1) ——
(M EX Tow Fewt Qries Jed Sgwch Took Wndow Hob 5 L .

Selec-‘- New SEEL 2 BRI ALAN /PR v T BT

) e o LT U

“ BB unassigned Notes

Select Read:Outloud®. e R e Vot

The Add eText box will appear. Select cancel.
Type in the address of the webpage.

Use the Read buttons in the tooclbar to read the
page from top to bottom or select text and then
use the read buttons.

SOk wn e

Register How!

Bridges o5 hosting their secand Atuzine Technotogy m Education Semner on
ver. The tage 18 “Acting Readmg Strolegics
st Speoker 1x Joum Sedhle e

Note: in this mode the student can't format the e

Leorm morc abovt PRic seminar

ma‘rerlﬂ! Tha‘r 1S be[ng r‘ead' ﬁf:::bw: Four Scdilo ot www seditoloarning com

bridgos Sommer Learting Serior

Reading the Internet - off-line _
fent Log-in -New - Read:Outloud® - Cancel - Type internet address - Insert- Capture Web Page

~ 1. Follow steps 1-4 above.
2. Go to Insert(in the menu bar) and select Capture Webpage.
3. You will now be reading off line. '

This material can be saved if necessary. It will be saved as an html file that can't be edited.

“$._ When logged on as a student, text can't be edited that is captured from a webpage. If you logonasa
!{ = j teacher, select New in Read:OQutloud®, and capture a webpage you will be able to edit the webpage (eg.
L-<’ format text, add spacing, colour text) and assign it to a student to read.

Bridges Canada
September 2005 www.bridges-canada.com 1-800-353-1107 3of3




Bridges

Bridges Assistive Technology in Education Seminar
Active Reading Strategies using Assistive Technology

Curriculum Websites Reference Page

Some tips:

e Always choose web pages that have clear graphics and fext.

e Choose webpages that have graphics that clearly iflustrate the text.
» Choose webpages that have limited advertising or links to advertising

e Turn on your internet security to limit access to advertising popups (Tools, Internet Options, Privacy tab, move the slider bar

to block all cookies)

e Many websites of fer "print versions* of their webpage. These tend to be less cluttered.

Some of these are complete websites and some are WebPages suggested for use with the Active Reading Strategies seminar.
www kidsclickorg A reference site developed by librarians. Provides lists of well-designed web pages in a variety of curriculum

areas also provides grade level and reading fevel for each web page referenced.

www_factmonster.com Provides search capabilities for dif ferent topics (math, science,
sports, world news). Developed by Pearson Publishing. Has printable versions of each

page.

http://www.ran.org/ Information about the rainforest. Choose Teachers and Students tab and Fact Sheets

Abgut Rainforests

Wt Yeu

wve
Iy g iy At a3

e |
rm Sh“k b

e ey P

e eyt 2 e, e Trwpicnl roinforest
i ey 7 e 4y B arm e Eunth s albost fiming

http://www.energyquest.ca.gov/story/index.html Developed by the Canadian Government. Presents like a text-book, hasa

wonderful overview of energy.
The Energy Story - Table of Contents

i

Enorgy- what i 17
icit

Swic Eledrichy & Rosistance

Elsctrics Circuts

S
i

1] Géothermd Enargy

Hydka Powac

Nucloar Energy - Fission end Fusion
O

Soler Erecgy

Reooratly v
CM_ISMEW Enargy EMclency

Hycrugen end Enepy O Firs
Qmﬂﬂm
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http://www.thecanadianencyclopedia.com An excerpt from the Canadian Encylopedia about -
native people of Canada.

www howstuf fworks.com A website that describes how
science, computer, money, travel, heath, etc things work.
Has excellent diagrams and pictures and the option for a

L tenpds el
W,I_._I

ontury.#you favt B trom D 1920,
Jch 0 you® o and R s werc At

e wery sbagac waciong bricphons mcul] Dok ey T ke

i, - s printable version.
-
R I
s =
P A

A L Ean bow, K M CONENS FYEH 50 wnd By I M T

Aupae - [y bl &
perdraty Cad 1 hadk aiveh § COnects when you L e et

= Acspaihr - Tha i gontrdy s D $0.cend, $.0tm iy o Tome 0L

karaphen ~3 B PR, icphone scr g ONC fene been e sheple =3

- X E

Hative People

Euzabe gt 1hg Inpra ekiterss f Qanace Ihn, wr

¥ pon year

hitp://www.seaworld.org/infobooks/Gorilla’home html A nice webpage about Gorillas from Busch Gardens. Hos clear text and

graphics and the content is organized into chapters.

Visit the Busch 6ardens/Seaworld website for more fantastic info sheets

and books on animals, ecosystems and habitats. www buschgardens.com Choose the Tampa Bay location, choose park information

and then Education Resources.

http://www.biclogy.arizona.edu/ The Biology Project is an interactive online resource
for learning biclogy developed at The University of Arizona. It has educational
illustrations and has been tested on 1000s of students. It has been designed for
biology students at the college level, but is useful for high school students, medical
students, physicians, science writers, and all types of interested people. Has
printable formats.

hf’rp://www.em.qov.bc.ca/Mininq/Geolsurv/Surficia[/quake/defuul’r.htm
British Columbia Ministry of Energy and Mines website - information on earthquakes in
British Columbia.

Extrerme Sciencs

Al g
The Mot EXrTme Scic0as Conte on the TR

e Schmein § Tt e G bepert, bkl i T TS e
k] apared - Vs st e o] e b L ICKECE,
o Flan = ot gt by <
e habind

- ‘e ek bk 13 #e0 B B i e e

www histori.ca Resources on Canadian Histery. Good fext information as well as

links to other websites.

S
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http://www.extremescience.com/ A reference site about extreme science, great for reluctant
readers. Very interesting, great graphics. The World Records section is great.
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es of popular baoks), and study guides. It provides print

www.bookrags.com Has a collection of eboeks, booknotes (summari
oose Free Book Notes from under the English section.

versions. For summaries of popular books such as Harry Potter, ch

hﬂp://www.nationalqeoqraphic.com/kidS/ Has a large selection of animal
fact files “creature features” which include text, pictures, sound files

{INALGEOCRAPHIC.CON! Kids

and videos of animals.

Aurgmy arat

hﬂg://www.windows.ucar'.edu/ Windows to the Universe. A Wiadns 1o o Universe
website developed by the University of California. Has tiered
reading material (beginner, intermediate, and advanced).
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Digital Formats of Authorized English
Language Arts Novels for Grades 4—12

A number of the novels authorized to support the Grades 4 to 12 English Language Arts
program of studies are available in digital formats, including; '

e e-texts
¢ considerate texts
» digital versions of synopses and study guides

These digital formats can be read from a computer or, in some cases, a portable digital
assistant (PDA). The digital format allows users to change the visual display (font,
background, etc.) and use other tools such as Read & Write Gold software so the text is
read aloud for the student. The advantage of these types of e-books is that students can
have access to both the visual and auditory version of the text at the same time. These
digital formats can be used to meet the diverse learning needs of students, including
students who have difficutty with print.

Free electronic books

These novels are available to be read online or downloaded for no cost. They are
copyright-free and/or in the public domain. They tend to be novels written seventy-five

Years ago or niore.

Etectronic books for purchase

There are a number of electronic books available for purchase. Generally, they can be
used with text to speech software but there are some exceptions. Please check a specific
text’s compatibility with accessibility software before making the purchase.

Considerate texts

The term “considerate texts™ (sometimes called “reader-friendly texts”) describes the
redesign of an original text into an easy-to-read format that considers students’ reading
abilities, interests, motivation and prior knowledge. These high interest/low vocabulary
versions of texts are for readers who may experience difficulty with the vocabulary or
readability level of the orginal text. They can be available in both print and digital
formats. Samples ot available digital formats are included in this list. These resources
have not been reviewed by Alberta Education and are included on this list for information
purposes only. School junisdictions and classroom teachers are responsible for
previewing these materials before using them with students.



